
GRADUATE COUNCIL: NEW COURSE PROPOSAL 

Originating Unit: 

Type of action:                 New course           Full online course**      

Semester and year course will take effect: 

New course title: 

Appropriate computer abbreviation (30 spaces or less):  

Course instructional methodology: 

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf 

New course number:  

Prerequisites for new course: 

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

include an attachment if additional space is needed



Description of new course (catalog copy): include an attachment if additional space is needed

attached files can be seen and managed in Acrobat Pro by clicking on 
View > Show/Hide > Navigations Panes > Attachments



Does this change affect any other units of the University?          Yes          No 
If yes, submit supporting statement signed by chair of affected unit. 

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and 
the cross-listed units. 

Fully Online Courses** 
All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state 
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.  
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.  
Contact the Koehler Center for Teaching Excellence for guidelines.  Include a letter of support from the Koehler Center 
with this proposal. 

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives, 
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if 
additional space is needed

Additional resources required: 

Faculty: 

Space: 

Equipment: 

Library: 

Financial Aid: 

Other: 

Change in teaching load:

attached files can be seen and managed in Acrobat Pro by clicking on 
View > Show/Hide > Navigations Panes > Attachments
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GIS: Analytics for Interactive Mapping to Solve Business 

Problems 

INSC 71140 (1.5 credit hours) 

Professor: Laura Meade, Ph.D.  

Office: Neeley 3250 

Office Phone: 817-257-7036; Cell Phone 817-800-2655 

Office Hours: T/TH 11:00-12:30; 3:30-4:00 pm and by appointment. 

 E-Mail: L.Meade@tcu.edu 

All emails usually answered within 24 hours M-F. 

 

TCU Mission Statement 

To educate individuals to think and act as ethical leaders and responsible citizens in the global 

community. 

The Neeley Mission Statement 

• To develop ethical leaders with cutting-edge business competencies and a global 

perspective who help shape the business environment. 

• To develop and disseminate leading-edge thought to improve the practice of business and 

contribute to the greater good. 

The Neeley Promise 

The Neeley School of Business unleashes human potential with leadership at the core and 

innovation in our spirit. 

Final Exam Date & Other Important Dates 

Final Delivery Due Date & Other Important Dates 

• Project Presentations Sunday, Dec. 19th  
• Final Individual write-up Due Monday, Dec 27th   8:00 am  

Course Description 

Learning Outcomes 

Learn GIS – a mapping and business analysis tool for applying geospatial analytics to your 
business practices.  Gain greater insights using contextual tools to manage, visualize and 
analyze your data as you collaborate and share via maps, dashboards and reports.  Specifically, 
GIS is an online geographic information system and is used to solve a variety of issues in many 
disciplines including data visualization, location analysis, environmental, social and corporate 
governance (ESG) and network design.  Through a series of tutorials and a team-based project 
learn to connect people, locations and data using layers of information.  

mailto:L.Meade@tcu.edu
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Students will do the following:  

• Complete tutorials on the essentials of GIS and state-of-the-art geospatial technology 
and web mapping techniques.  

• Complete ESG transparency project 
• Conduct a current state analysis of Tesla’s Gigafactory locations.  
• Present results from multi-country and multi-city analysis based on GIS tools.  
• Define a current business problem and present solution based on GIS analytical tools 

including multiple layer analysis, suitability analysis and infographics.  
• Reflect and summarize how geographic information systems can enhance a selected 

discipline or profession.   

Prerequisites  

Graduate Student currently enrolled in the Neeley School of Business 

Required Texts / Materials  

Access to ArcGIS as TCU student (TCU has a site license)  

Essentials of Geographic Information Systems” version 2.1 by Michael, Shin, Jonathan 
Campbell, and Nick Burkhart.  Published by FlatWorld. 

• Our website, where they can purchase an ebook, with student supplements, 
for $29.95.  This link will take them directly to the materials for the 
course: https://students.flatworldknowledge.com/course/2598857 

• When the student visits the site, via the direct 
link https://students.flatworldknowledge.com/course/259885  can also opt to purchase a 
downloadable or a print copy of the book at our website.  

Reference Materials  

Databases 

STAT.USA, NTDB (National Trade Data Bank), (Available through TCU Library’s On-line 
Resources) 

 

Websites 

The U.S. Government Export Portal (http://www.export.gov/) 

U. S. Customs and Border Protection (http://www.customs.gov/) 

Lloyd’s Register Fairplay World Shipping Directory (http://directory.fairplay.co.uk/) 

International Chamber of Commerce (http://www.iccwbo.org/) 

International Trade Association (http://www.ita.doc.gov/) 

U.S. Census Bureau   (http://www.census.gov/foreign-trade/top) 

http://hbr.org/hbrg-main/resources/pdfs/extras/javidan.pdf (cornucopia of international business 
resources) 

Real Clear:   Editorialists and writers from around the English-speaking world  
www.realclearworld.com 

Daily Telegraph:  http://www.telegraph.co.uk/  (generally Eurosceptic point of view) 

https://urldefense.com/v3/__http:/www.flatworld.com/__;!!K6Z8K8YTIA!QmLguoZkI7hh8fxxCu6qmq9dyBR7p00CigqJ66HdySTqBJdjx8Yc_taW-a4fAw$
https://urldefense.com/v3/__https:/students.flatworldknowledge.com/course/2598857__;!!K6Z8K8YTIA!QmLguoZkI7hh8fxxCu6qmq9dyBR7p00CigqJ66HdySTqBJdjx8Yc_tYCPMGKTg$
https://urldefense.com/v3/__https:/students.flatworldknowledge.com/course/2598857__;!!K6Z8K8YTIA!QmLguoZkI7hh8fxxCu6qmq9dyBR7p00CigqJ66HdySTqBJdjx8Yc_tYCPMGKTg$
http://www.export.gov/
http://www.customs.gov/
http://directory.fairplay.co.uk/
http://www.iccwbo.org/
http://www.ita.doc.gov/
http://www.census.gov/foreign-trade/top
http://hbr.org/hbrg-main/resources/pdfs/extras/javidan.pdf
http://www.realclearworld.com/
http://www.telegraph.co.uk/
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The Economist:  www.economist.com  (Another British publication, but a bit more moderate 
than the Daily Telegraph) 

 

Teaching Philosophy 

“The real challenge in college teaching is not covering the material for the students; it’s 
uncovering the material with the students”  Karl Smith, 1994 
 
 

Instructional Methods 

This course is an intensive weekend course and is designed around INTERACTIVE discussions, 
readings, tutorials and team projects.  Therefore, attendance and participation are critical success 
factors for learning.  Since this is an intermester course, NO LATE WORK will be accepted.  
 

TECHNOLOGY 

TCU ONLINE:  This course uses D2L (TCU’s Online format) this is where assignments will be 
turned in and class sessions and presentations. 

 

Grading  

Final Grade Elements / Grade Breakdown: 

Outcome(s) 
Assignments, Exams/Quizzes, 

Presentations, etc. 
Percentage 

Complete tutorials on the 
essentials of GIS and state-of-the-
art geospatial technology and web 
mapping techniques.  

 

Individually complete assigned 
tutorials  

10 % 

Conduct ESG transparency and 
traceability analysis 

Individually complete sourcing 
materials responsibly analysis 

15% 

Conduct a current state analysis of 
Tesla’s Gigafactory locations 

 

Individually complete current 
location analysis (Phase 1 and 2)  

10% 

Present results from multi-country 
and multi-city analysis based on 
GIS tools.  

 

Team presentation of 3 country 
analysis and Mexico city analysis 
(Phase 3)  

20% 

Define a current business problem 
and present solution based on GIS 
analytical tools including multiple 
layer analysis, suitability analysis 
and infographics.  

Team presentation implementing 
GIS tools, including suitability 
analysis and infographics to solve 
current business problem.  

20% 

http://www.economist.com/
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Outcome(s) 
Assignments, Exams/Quizzes, 

Presentations, etc. 
Percentage 

 

Reflect and summarize how 
geographic information systems 
can enhance a selected discipline 
or profession 

Final Individual Paper  25% 

GRADING 

Instructions for Tutorials and TESLA project are in D2L. 

GROUP FINAL PROJECT PRESENTATION 

This project assignment is purposefully designed to be vague so use your imagination and 
creativity.  ArcGIS is a powerful tool designed to help solve for a myriad of business issues. 
Your project MUST contain the following elements:   

1.  Problem Statement 

2. Utilization of the following in ArcGIS 

a. Mapping of layers 

b. Import of some external data (via spreadsheet) 

c. Suitability Analysis 

d. Infographic 

3. At least 4 different maps 

4. What GIS solved for your business problem and what it cannot solve. 

5. Final Conclusion 

Grading Rubric is posted in D2L under the “Final Project” module 

(There are MANY more databases available when analyzing an issue within the United States; 

i.e. where to locate a Farm to Table Restaurant in Dallas – income, education, traffic patterns, 

availability of suppliers, access to workers, weather, location of EV charging stations…etc. ) 

Explore and use data layers in ArcGIS Online and Living Atlas as had to do for current locations 

of Tesla Megafactories)   

Individual Final Reflection on GIS and how it can enhance a selected 
discipline or profession  

Analytical tools are becoming more and more prevalent in the workplace.  Select and specific 
discipline or profession and summarize how geographic information systems can be used for a 
competitive advantage.  Please use headings in your write-up and limit it to 4 pages including 
figures and bibliography.  Your report must contain the following: 

1. Introduction:  Description of specific profession or discipline you are analyzing.   

2. Geographic Information Systems:  Discussion of the current state of adoption of geospatial 
technology and web mapping in selected profession/discipline. Provide at least three examples. 

3. Suggestions for Future:  Expert suggestions as to how GIS could be used in selected 
profession/discipline.  

4. Conclusion:  Include how taking this course will help you in your chosen career path 
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6. Bibliography:  Cite and incorporate in your discussion at least 6 sources.  

 

Grading Scales 

 

All final grades will be rounded to the nearest tenth. 

 

 

Late Work 

No late work will be accepted unless prior arrangements have been made with the professor.   

Grading Concerns 

If you have a question about your grade on an assignment you must contact me in person or via 
email within 48 hours of receiving my feedback.   

 

 

INFORMATION YOU MAY NEED 

Syllabus Disclosures 

Fall 2022 
 

Technology Policies 

Email 

Only the official TCU student email address will be used for all course notification. It is your 

responsibility to check your TCU email on a regular basis. 

Course Materials 

TCU students are prohibited from sharing any portion of course materials (including videos, 

PowerPoint slides, assignments, or notes) with others, including on social media, without written 

permission by the course instructor. Accessing, copying, transporting (to another person or 

location), modifying, or destroying programs, records, or data belonging to TCU or another user 

without authorization, whether such data is in transit or storage, is prohibited. The full policy can 

be found at: https://security.tcu.edu/polproc/usage-policy/. 

Grade Score Grade Score 

A 94–100 C 74–76.9 

A- 90–93.9 C- 70–73.9 

B+ 87–89.9 F 0–69.9 

B 84–86.9   

B- 80–83.9   

C+ 77–79.9   

https://security.tcu.edu/polproc/usage-policy/
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Violating this policy is considered a violation of Section 3.2.15 of the Student Code of 

Conduct (this policy may be found in the Student Handbook at https://tcu.codes/code/index/), 

and may also constitute Academic Misconduct or Disruptive Classroom Behavior 

(these policies may be found in the undergraduate catalog at 

https://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-

Conduct-Policy-Details). TCU encourages student debate and discourse; accordingly, TCU 

generally interprets and applies its policies, including the policies referenced above, consistent 

with the values of free expression and First Amendment principles. 

 

Academic Misconduct 

Academic Misconduct (Sec. 3.4 from the TCU Code of Student Conduct): Any act that violates 

the academic integrity of the institution is considered academic misconduct. The procedures 

used to resolve suspected acts of academic misconduct are available in the offices of Academic 

Deans and the Office of Campus Life and are also listed in detail in the Undergraduate Catalog 

and the Graduate Catalog Specific examples include, but are not limited to:  

• Cheating: Copying from another student’s test paper, laboratory report, other report, or 

computer files and listings; using, during any academic exercise, material and/or devices 

not authorized by the person in charge of the test; collaborating with or seeking aid from 

another student during a test or laboratory without permission; knowingly using, buying, 

selling, stealing, transporting, or soliciting in its entirety or in part, the contents of a test 

or other assignment unauthorized for release; substituting for another student or 

permitting another student to substitute for oneself.  

• Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s 

work, and the unacknowledged submission or incorporation of that work as one’s own 

offered for credit. Appropriation includes the quoting or paraphrasing of another’s work 

without giving credit therefore. [If you are using Turnitin, place information about your 

course ID/password or state that items will be checked as part of the TCU Online 

assignment submission process. If you want to use Turnitin as a spot check, indicate that 

you may use Turnitin for plagiarism detection.] 

• Collusion: The unauthorized collaboration with another in preparing work offered for 

credit. 

• Abuse of resource materials: Mutilating, destroying, concealing, or stealing such 

material. 

• Computer misuse: Unauthorized or illegal use of computer software or hardware 

through the TCU Computer Center or through any programs, terminals, or freestanding 

computers owned, leased or operated by TCU or any of its academic units for the 

purpose of affecting the academic standing of a student. 

• Fabrication and falsification: Unauthorized alteration or invention of any information or 

citation in an academic exercise. Falsification involves altering information for use in any 

academic exercise. Fabrication involves inventing or counterfeiting information for use in 

any academic exercise. 

• Multiple submission: The submission by the same individual of substantial portions of 

the same academic work (including oral reports) for credit more than once in the same 

or another class without authorization. 

• Complicity in academic misconduct: Helping another to commit an act of academic 

misconduct. 

https://tcu.codes/code/index/
https://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
https://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
https://tcu.codes/code/index/3-prohibited-conduct/3-4-academic-misconduct/
http://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct
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• Bearing false witness: Knowingly and falsely accusing another student of academic 

misconduct.  

Class Norms & Netiquette 

All members of the class are expected to follow rules of common courtesy in all email messages, 

discussions, and chats. If I deem any of them to be inappropriate or offensive, I will forward the 

message to the Chair of the department and appropriate action will be taken, not excluding 

expulsion from the course. The same rules apply online as they do in person. Be respectful of 

other students. Foul discourse will not be tolerated. Please take a moment and read the basic 

information about netiquette (http://www.albion.com/netiquette/). 

Participating in the virtual realm, including social media sites and shared-access sites sometimes 

used for educational collaborations, should be done with honor and integrity. Please review 

TCU’s guidelines on electronic communications (email, text messages, social networks, etc.) from 

the Student Handbook. (https://tcu.codes/policies/network-and-computing-policy/e-mail-

electronic-communications-social-networks/) 

  

TCU Online: Our Learning Management System 

Getting Started with TCU Online 

Technical Requirements: Check your computer is ready by looking at the specifications list. 

(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements) 

 

Log In: (using your TCU Network Credentials) 

Option 1: Access via my.tcu.edu > Student Quick Links > TCU Online 

Option 2: Login at http://d2l.tcu.edu 

*For information about logging into TCU Online, view these instructions 

(http://tcuonline.tcu.edu/kb/how-do-i-log-in/). 

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online 

Student Orientation Tutorial, please do so now. To access it, click on the Orientations semester 

OR view all courses in your My Courses widget visible upon logging in to TCU Online. Click on 

the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the 

course. You can return to this tutorial at any time. 

. 

 

Getting Help with TCU Online 

If you experience any technical problems while using TCU Online, please do not hesitate to 

contact the TCU Online (D2L) Help Desk. They can be reached by phone or chat 24 hours a day, 

7 days a week, 365 days a year.  

Phone: 1-877-325-7778 

Chat: Chat is available within TCU Online in the Help menu on the navigation bar. 

http://www.albion.com/netiquette/
http://www.albion.com/netiquette/
http://www.albion.com/netiquette/
https://tcu.codes/policies/network-and-computing-policy/e-mail-electronic-communications-social-networks/
https://tcu.codes/policies/network-and-computing-policy/e-mail-electronic-communications-social-networks/
https://tcu.codes/policies/network-and-computing-policy/e-mail-electronic-communications-social-networks/
https://tcu.codes/policies/network-and-computing-policy/e-mail-electronic-communications-social-networks/
https://community.brightspace.com/s/article/Brightspace-Platform-Requirements
https://community.brightspace.com/s/article/Brightspace-Platform-Requirements
http://my.tcu.edu/
http://d2l.tcu.edu/
file:///C:/Users/lmead/Box/INSC%2040353/2022GSC/instructions
http://tcuonline.tcu.edu/kb/how-do-i-log-in/
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If you are working with the Help Desk to resolve a technical issue, make sure to keep me updated 

on the troubleshooting progress. 

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please 

contact me. 

Personal Settings & Notifications for TCU Online 

As a student, you should set up your account settings, profile, and notifications. To do this you 

will login to TCU Online and select your name on the top right of the screen. In the Profile area, 

you can upload a photo of yourself and add personal information. In the Notifications area, you 

can add your phone number to receive text messages when grades are given as well as 

reminder texts for upcoming assignments and quizzes.  

Student Success Tools for TCU Online 

Pulse 

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and 

announcements. This app provides a graph that can help you manage your time. Based on the 

number of assignments and events on the course calendar for your classes, the graph will 

display busy times for class work in the upcoming week. You can use this app to manage your 

daily workload, and it includes the ability to view and access course materials offline. You can 

download Pulse from the Google Play or Apple Store. You can learn more and download Pulse 

here: https://www.d2l.com/products/pulse/. 

 

ReadSpeaker 

ReadSpeaker includes a number of tools that can enhance your understanding and 

comprehension of course materials. ReadSpeaker can create an audio version of content that 

you can listen to while on a page within a course or that you can download to listen offline. 

ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and 

features to assist you with reading and focusing in TCU Online, tools that provide support for 

writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn 

more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-

hub/instructor-how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/ 

Support for TCU Students 

Campus Offices 

• Academic Advising (817-257-7486, Jarvis 104) 

• Brown-Lupton Health Center (817-257-7938 or 817-257-7940) 

• Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003) 

• Center for Writing (817-257-7221, Reed Hall 419) 

• Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2nd floor) 

• Dean of Students (817-257-7926, the Harrison 1600) 

• Mary Couts Burnett Library: Reference Desk (817-257-7117)  

• Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1st floor) 

https://www.d2l.com/products/pulse/
https://www.d2l.com/products/pulse/
https://tcuonline.tcu.edu/how-to-hub/instructor-how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/
https://tcuonline.tcu.edu/how-to-hub/instructor-how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/
https://tcuonline.tcu.edu/how-to-hub/instructor-how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/
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• Student Access & Accommodations (817-257-6567, The Harrison 1200) 

• Student Success (817-257-8345, Samuelson Hall, West Entrance) 

• Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2nd floor) 

• Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)  

• Veterans Services (817-257-5551, Jarvis Hall 2nd floor) 

 

Anti-Discrimination and Title IX Information 

Statement on TCU’s Non-Discrimination Policy 

TCU is committed to providing a positive learning, living, and working environment free from 

unlawful discrimination, harassment, sexual misconduct, and retaliation. In support of this 

commitment, in its policy on Prohibited Discrimination, harassment, sexual misconduct and 

retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and 

harassment and related sexual and other misconduct based on age, race, color, religion, sex, 

sexual orientation, gender, gender identity, gender expression, national origin, ethnic origin, 

disability, predisposing genetic information, covered veteran status, and any other basis 

protected by law. The Office of Institutional Equity (OIE) is responsible for responding to all 

reports of discrimination, harassment, sexual misconduct and retaliation. 

 

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment, 

Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to Reports of 

Prohibited Discrimination, Harassment, Sexual Misconduct, and Retaliation.  

 

To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The Harrison, 

Suite 1800 or click here: Make a Report. 

To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident click 

here: https://inclusion.tcu.edu/campus-community-response-team/ 

 

Title IX 

TCU’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU’s Title IX 

Coordinator. You may call 817-257-8228 to make a report, email oie@tcu.edu or 

a.vircks@tcu.edu, or make a report here. Additional Title IX resources and information are 

available at https://www.tcu.edu/institutional-equity/title-ix/index.php. 

 

Mandatory Reporters 

ALL TCU employees, except confidential resources, are considered Mandatory Reporters. 

Mandatory reporters are required to immediately report to OIE any conduct that raises 

Discrimination, Harassment, Sexual Misconduct (Title IX or Violence Against Women (VAWA)) or 

Retaliation. Mandatory reporters cannot promise to refrain from forwarding the information to 

OIE. 

 

https://tcu.policytech.com/dotNet/documents/?docid=135&public=true
https://tcu.policytech.com/dotNet/documents/?docid=135&public=true
https://tcu.policytech.com/dotNet/documents/?docid=140&public=true
https://tcu.policytech.com/dotNet/documents/?docid=140&public=true
mailto:oie@tcu.edu
https://www.tcu.edu/institutional-equity/make-a-report.php
file:///C:/Users/lmead/Downloads/To%20learn%20about%20the%20Campus%20Community%20Response%20Team%20(CCRT)%20and%20Report%20a%20Bias%20Incident%20click%20here:
file:///C:/Users/lmead/Downloads/To%20learn%20about%20the%20Campus%20Community%20Response%20Team%20(CCRT)%20and%20Report%20a%20Bias%20Incident%20click%20here:
https://inclusion.tcu.edu/campus-community-response-team/
mailto:oie@tcu.edu
mailto:a.vircks@tcu.edu
https://www.tcu.edu/institutional-equity/make-a-report.php
https://www.tcu.edu/institutional-equity/title-ix/index.php
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Confidential On-Campus Resources 

Campus Advocacy, Resources & Education 

www.care.tcu.edu | 8147-257-5225 

Counseling & Mental Health Center 

www.counseling.tcu.edu | 817-257-7863 

Religious & Spiritual Life 

www.faith.tcu.edu | 817-257-7830 

 

On Campus Resources 

TCU Police 

www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency 

 

TCU Policy for Religious Observations & Holidays 

“Students who are unable to participate in a class, in any related assignment or in a university 

required activity because of the religious observance of a holy day shall be provided with a 

reasonable opportunity to make up the examination or assignment, without penalty, provided 

that it does not create an unreasonable burden on the University.” For more information, please 

visit the TCU Policy for Religious Observations & Holidays webpage. 

 

Student Access and Accommodation 

Texas Christian University affords students with disabilities reasonable accommodations in 

accordance with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act. To 

be eligible for disability-related academic accommodations, students are required to register 

with the TCU Office of Student Access and Accommodation and have their requested 

accommodations evaluated. If approved for accommodations, students are required to discuss 

their official TCU Notification of Accommodation with their instructors.  Accommodations are 

not retroactive and require advance notice to implement. The Office of Student Access and 

Accommodation is located in The Harrison, Suite 1200. More information on how to apply for 

accommodations can be found at  https://www.tcu.edu/access-accommodation/  or by calling 

Student Access and Accommodation at (817) 257-6567. 

Audio Recording Notification:  

Audio recordings of class lectures may be permitted by the instructor or as an approved 

disability accommodation through Student Access and Accommodation. Recordings are not to 

be shared with other students, posted to any online forum, or otherwise disseminated. 

 

Emergency Response Information 

View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek 

Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/) 

http://www.care.tcu.edu/
http://www.counseling.tcu.edu/
http://www.faith.tcu.edu/
http://www.police.tcu.edu/
https://faith.tcu.edu/rhp/
https://www.tcu.edu/access-accommodation/
https://publicsafety.tcu.edu/less-is-more/
https://publicsafety.tcu.edu/less-is-more/
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View the TCU Building Safety Maps that show the specific seek shelter locations and building 

rally points for evacuation. (https://publicsafety.tcu.edu/less-safety-maps/)  

View the TCU Evacuation Rally Point Map to see all rally points for evacuation. 

(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)  

Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/). 

In the event of an emergency, call the TCU Police Department at 817-257-7777.  

 

COURSE SCHEDULE 

This calendar represents my current plans and objectives.  As we go through the course, those 

plans my need to change to enhance the class learning opportunities.  Such changes will be 

clearly communicated.   

 

Friday 12/23 Saturday(12/24)  Sunday(12/25) Monday(12/26) 

6:00-8:00 pm  

Introduction to 

Geographic 

Information 

Systems 

8:00 – 9:00 am work 

on Tutorials 

9:00 am Tutorials Due 

9:00 -12:00 pm 

ESG Lecture and 

Introduce 

Transparency and 

Traceability exercise 

8:00 am – 10:00 am  

10:00 am – 12:00 pm 

Complete Tesla 

Project  

Lecture on ArcGIS 

Business Analyst 

Web App 

Individual write-up 

due 

(8:00 am) 

8:00-10:00 pm 

work on 

tutorials 

1:00-2:00 pm Lecture 

on adding layers 

2:00 -Work on Tesla 

Project (3 phases) 

3:30-4:00 Phase 1 

Tesla due 

Introduce Phase 2 

Lecture on 

incorporating 

spreadsheets and 

datasets.  

 

1:00 – 1:30 pm  

Introduce Group 

Final Project 

1:30-5:00 Work on 

Group Project 

 

 6:00 pm Tesla Phase 2 

due 

 

5:00 – 6:00 pm 

Group Final Project 

Presentations 

 

https://publicsafety.tcu.edu/less-safety-maps/
https://publicsafety.tcu.edu/less-safety-maps/
https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf
https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf
file:///C:/Users/joannaschmidt/Downloads/Frogshield%20Campus%20Safety%20App
https://police.tcu.edu/frogshield/
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